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1   Getting Started

The Serial Service Tool is an easy-to-use program to manage firmware updates and configuration for 
Redekop ECUs. It is designed for use with the RP1700 Serial Service Tool adapter.

The Serial Service Tool has the following features:

	 •	 Connected ECU information is displayed, such as hardware version, serial number, and 		
		  installed firmware version.

	 •	 ECU Firmware can be updated and verified.

	 •	 Single-Click process for bulk update of multiple ECUs.

	 •	 Installed features, settings, and calibrations can be kept or reset to default configuration 		
		  when updating firmware.

	 •	 Hour meters for Chopper and Seed Control Unit can be kept or reset to zero when updating 	
		  firmware.

	 •	 Alarm history can be kept or cleared when updating firmware.

	 •	 Installed features, settings, and calibrations can be edited and saved to the ECU.

	 •	 Hour meters can be edited and saved to the ECU.

	 •	 A complete factory reset can be performed to return the ECU to its default state.

	 •	 For updating hours on an Android Tablet based installation, a reset key can be generated.

	 •	 Upload and Manage Update Packages on Android Tablet.
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1.1   Software Installation 

To use the ECU Service Tool, the Service Tool application must be installed on a compatible Windows PC:

System Requirements

	 • OS: Windows 10 / Windows 11
	
	 • Processor: 1 Ghz
	
	 • Memory: 512 MB
	
	 • Minimum Disk Space: 4.5 GB
	
	 • .NET Framework 4.8

Internet Access

Internet access is required to install (and update) the Service Tool application. After installation is complete, 
internet access is not required to use the Service Tool except to update the application and obtain new 
firmware versions.

Security Warning

Since the application was developed without certain security features, Windows may warn that the 
publisher of the application cannot be verified. This is normal, and the application is safe to run, as long as 
it was downloaded from the link shown on this page.

Please contact Redekop support with any questions or concerns.

To Install Application

	 1. Download Service Tool application on a compatible Windows PC: 
		  a. Go to https://redekopmfg.com/ecu-tool.
		  b. Click Install.
	 2. Locate and open the downloaded ServiceTool.application file.
	 3. If prompted by a Security Warning, read the warning and click Install (See Note above).
	 4. After the application has finished installing, Windows may show another warning. At the Windows 	
	    protected your PC screen, read the warning and click More Info and then Run anyway 
	    (See Note above).
	 5. The Service Tool application icon will be available in the Start Menu, under the 
	     Redekop Manufacturing folder.

To Update Application
	 1. The Service Tool application automatically checks for updates and new firmware versions on 
	     startup, as long as the PC is connected to the internet.
	 2. If a new version is detected, it will be downloaded automatically and installed.

Application Updates
	 It is recommended to run the Service Tool application periodically while connected to the internet to
	 check for updated firmware.
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1.2   Serial Tool Basics

The Serial Service Tool consists of:

	 •	 USB Serial COM Port Adapter

	 •	 Reset Button

	 •	 Auto-Mode Switch

	 •	 Power Light

	 •	 Transmit and Receive Lights

	 •	 ECU Connector

	 •	 USB Connector

The Service Tool application must be installed to use the adapter. See Software Installation.
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1.3   Basic Operation

When connected to the ECU, the Service Tool adapter provides power to the ECU and places it in 
Programming mode, which is used to update and verify the installed firmware. In case the ECU has 
entered Run mode instead, a reset button is provided to restart the ECU and enter Programming mode.

In Auto-Mode, the Service Tool automatically powers the ECU on and off as needed to access the different 
operating modes. The Auto-Mode Switch can be used to disable this feature; however the ECU will need 
to be reset manually if needed with the Reset Button.

1.4   ECU Modes

The ECU has three operating modes:

	 •	 Run Mode: This is the normal operating mode of the ECU. In this mode, the Power LED 		
		  on the ECU will turn on once the ECU has started up, and the CAN LED indicates 		
		  communication activity with the connected ISOBUS display or Android Tablet.

	 •	 Programming Mode: This is a special mode which is used to read and write the firmware to 	
		  the ECU. It is activated using the Service Tool adapter. None of the ECU LEDs turn 		
		  on in this mode.
	
	 •	 Memory Mode: This mode is used to read and edit the saved configuration of the ECU, as 	
		  well as hour meters and alarm history. It can only be entered from Programming mode. The 	
		  ECU Power LED will blink slowly in this mode.

1.4.1   Programming Mode

While in Programming mode, the Service Tool adapter can directly access and manipulate the program 
memory on the ECU. The Service Tool can read and write to any part of the program memory, such as:

	 •	 ECU Serial Number

	 •	 Installed Firmware and Version

	 •	 Bootloader

	 •	 Other Boot Information

The Bootloader is a special component of firmware that manages the operation mode of the ECU.

In Programming mode, there are three commands available:

	 •	 Write - The current firmware on the connected ECU is erased and the target firmware is 		
		  written to the device. After the write is complete, the configuration is either reset or updated 	
		  according to the selected settings.

 



7

	 •	 Verify - The current firmware is read from the program memory and compared to the 		
		  selected firmware version included with the tool. This is useful to determine if the firmware 	
		  has become corrupted on the ECU.

	 •	 Bulk - Allows the user to program and configure ECUs in a loop, performing the same 		
		  operations as the Write command. After the Write command has completed, a new ECU can 	
		  be connected, and the process automatically resumes until cancelled by the user.

1.4.2   Memory Mode

Memory mode is automatically entered when required by the Service Tool to complete one or more of the 
supported commands.

Memory mode is only supported on Bootloader v03 and later.

While in Memory mode, the Service Tool adapter can access and manipulate the configuration memory on 
the ECU. This includes items other than the ECU firmware, such as:

	 •	 Installed Features

	 •	 Settings

	 •	 Calibrations

	 •	 Chopper and SCU Hour Meters

	 •	 Alarm History

In Memory mode, there are several commands available:

	 •	 Edit - Reads the currently installed features, settings, and calibrations from the ECU, as well 	
		  as current values of the Chopper and SCU hour meters and allows for manual configuration 	
		  prior to ECU installation. This can be used to transfer hours from one ECU to another in the 	
		  event of an exchange, for example.

	 •	 Reset - This command selectively resets the currently installed features, settings, and 		
		  calibrations to the default values, resets Chopper and SCU hour meters to zero, or clears 	
		  the alarm history.

	 •	 Factory Reset - This command completely resets the ECU to the factory default values, 		
		  including installed features, settings, calibrations, hour meters, and alarm history.
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2   How to... 

	 •	 Determining Correct Port

	 •	 Connecting to ECU

	 •	 Upgrading ECU Firmware

	 •	 Verifying ECU Firmware

	 •	 Bulk Upgrading Multiple ECUs

	 •	 Resetting ECU Configuration

	 •	 Editing ECU Configuration

	 •	 Updating Android Tablet App

	 •	 Factory Initializing Android Tablet
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2.1   Determining Correct Port 
less than 1 minute to read

To establish a connection to the ECU, the correct communication port must be selected using the Port 
dropdown.

To Determine the Correct Port:

	 1.	 Disconnect the Service Tool adapter USB cable from the PC.

	 2.	 Click the Port dropdown menu and take note of the available ports.
	
	 3.	 Click an empty area to close the Port dropdown menu.

	 4.	 Reconnect the Service Tool adapter USB to the PC.
	
	 5.	 Click the Port dropdown menu. By process of elimination, locate the newly added port and 	
		  select it.

2.2   Connecting to ECU 

To work with the Service Tool, you first need to establish a connection with an ECU. For most operations, 
if an error occurs, the ECU will automatically disconnect, and it may be necessary to connect again to 
continue.

Important

For installed ECUs, be sure to disconnect both connectors from the ECU prior to connecting the Service 
Tool.

To connect the Service Tool to an ECU:

	 1.	 If ECU is installed on machine, disconnect both connectors on the ECU.

	 2.	 Connect the Service Tool adapter to your PC via the USB connector.

	 3.	 Plug the Service Tool adapter into the ECU.

	 4.	 In the Serial Port section, choose the correct Port.

	 5.	 Press the Connect button.

	 6.	 When the connection is successful, the ECU Version, Serial Number, and Firmware Version 	
		  will be displayed.

Troubleshooting

If the ECU fails to connect, try one of the following before connecting again:
	 •	 Press and hold the Reset button on the Service Tool adapter for 2 seconds and release to 	
		  reset the ECU.

	 •	 If more than one Port is available, try a different port. See Determining Correct Port.
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2.3   Upgrading ECU Firmware

Upgrading ECU firmware using the Service Tool adapter is fast and easy.

To upgrade ECU firmware:

	 1.	 Prior to upgrade, take note of installed features, any customized settings, and hour meter 	
		  values.

	 2.	 Establish a connection to the ECU. See Connecting to ECU.
	
	 3.	 Select a firmware to write to the ECU by either:
		  •	 Selecting a firmware version from the Target Firmware dropdown.
		  •	 If instructed by Redekop technical support, selecting a Custom File.

	 4.	 Choose the desired Options for updating the ECU configuration. See Options.

	 5.	 Click the Write button. The Progress bar and Log show the progress of the current 		
		  operation.

	 6.	 Wait for the Write command to complete. A confirmation box will appear.

	 7.	 Click the Disconnect button and remove the ECU.

Warning

Cancelling the Write command will leave the ECU unable to boot. To recover the ECU, simply restart the 
upgrade process.
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2.4   Verifying ECU Firmware 

Verification of ECU firmware can be used to identify memory corruption or other problems.

Verification normally does not need to be completed except as instructed by Redekop technical support.

To verify ECU firmware:

	 1.	 Establish a connection to the ECU. See Connecting to ECU.

	 2.	 Select a firmware to write to the ECU by either:
		  •	 Selecting a firmware version from the Target Firmware dropdown.
		  •	 If instructed by Redekop technical support, selecting a Custom File.

	 3.	 Click the Verify button. The Progress bar and Log show the progress of the current 		
		  operation.

	 4.	 Wait for the Verify command to complete. A confirmation box will appear.

	 5.	 Click the Disconnect button and remove the ECU.
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2.5   Bulk Upgrading Multiple ECUs 

With Bulk Programming mode, it is possible to quickly update many ECUs in sequence.

To upgrade multiple ECUs in Bulk mode:

	 1.	 Establish a connection to the first ECU. See Connecting to ECU.

	 2.	 Select a firmware to write to the ECUs by either:
		  •	 Selecting a firmware version from the Target Firmware dropdown.
		  •	 If instructed by Redekop technical support, selecting a Custom File.

	 3.	 Choose the desired Options for updating the ECU configuration. These options will apply to 	
		  all ECUs programmed in Bulk mode. See Options.

	 4.	 Click the Bulk button. The first Write command will begin on the first ECU. The Progress 	
		  bar and Log show the progress of the current operation.

	 5.	 Wait for the Write command to complete. A message will appear in the log, prompting for the 	
		  next ECU.

	 6.	 Un-plug the current ECU and plug in the next. The Service Tool will automatically Connect, 	
		  and the process will resume.

	 7.	 When the final ECU is complete, click the Cancel button to exit Bulk programming mode. 	
		  The Service Tool will automatically Disconnect, and the final ECU can be un-plugged.

Note

During bulk programming mode, if an ECU fails to connect after being plugged in, simply press the Reset 
switch on the Service Tool adapter for 2 seconds and release to reset the ECU.
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2.6   Resetting ECU Configuration 

The ECU configuration can be reset to defaults using the Service Tool adapter.

To reset ECU configuration:

	 1.	 Establish a connection to the ECU. See Connecting to ECU.

	 2.	 From the Reset Menu, select Reset Configuration, Reset Hours, Clear Alarms, or 		
		  Factory Reset. See Reset Commands.

	 3.	 The Service Tool places the ECU in Memory mode and resets the current configuration 		
		  according to the selected command.

	 4.	 The Progress bar and Log show the progress of the reset operation.

	 5.	 Wait for the Reset command to complete. A confirmation will appear.

	 6.	 Click the Disconnect button and remove the ECU.
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2.7   Editing ECU Configuration 

The ECU configuration can be viewed and edited using the Service Tool adapter.

To edit ECU configuration:

	 1.	 Establish a connection to the ECU. See Connecting to ECU.

	 2.	 From the Edit Menu, select either Edit Configuration or Edit Hours. See Edit Commands.

	 3.	 The Service Tool places the ECU in Memory mode and reads the current configuration.

	 4.	 The Edit Dialog appears.

	 5.	 Edit the values as desired. Click Save to save the configuration to the ECU or Cancel to 		
		  revert any changes.

	 6.	 The Progress bar and Log show the progress of the save operation.

	 7.	 Wait for the Edit command to complete. A confirmation will appear.

	 8.	 Click the Disconnect button and remove the ECU.
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2.8   Updating Android Tablet App

The Android Tablet app can be updated using installation packages delivered with the Service Tool 
application.

ECU Version

The ECU firmware version must be matched to the installed Android Tablet app version for the system to 
function. Refer to the Package drop-down menu for the compatible ECU firmware version. Ensure ECU is 
updated to the required firmware version.

To Update Android Tablet App:

	 1. Ensure Android Tablet is powered on and unlocked.
	
	 2. Connect Android Tablet to PC with the USB cable. 
	    
	    If there is a pop-up on the Tablet screen, select Allow to allow the PC to access data on the 		
	    tablet.

	 3. In the Service Tool application, click the File Menu and select Tablet Packages. The Android 		
	    Tablet Packages dialog appears.
	
	 4. Select the correct device from the Device drop-down menu. 
	     - Click the Rescan button if the device is not present.

	 5. Select the desired Tablet app version from the Package drop-down menu. Make note of the 		
	     required ECU firmware version.

	 6. Click the Upload button.

	 7. After the upload has completed, on the Tablet, open the My Files app.

	 8. In the My Files app, select Installation Files from the left-hand menu.

	 9. Locate the uploaded installation package and tap it. Select Install. 

	     If the My Files app is not allowed to install unknown apps, select Settings and enable Allow 		
	     from this source. Repeat steps 7-9.
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2.8   Factory Initializing Android Tablet 

In some cases, it may be required to Factory Initialize an ECU in an Android Tablet installation.

Factory Initialization normally only needs to be performed when instructed by Redekop technical support.

To factory initialize ECU:

1.	 On Android Tablet, locate the Factory Initialization screen:
	 •	 In the Redekop Controller App v1.6.1, tap the button in the top corner, tap Service Menu, 	
		  again tap the button in the top corner, tap Factory Initialization.
	 •	 In the Redekop Controller App v1.8.1+, tap the button to enter the Settings Menu, tap the 	
		  button to enter the Service Interval Menu, tap the button, and tap Initialize Time.

2.	 If adjustments to the hour meters are required, adjust the Chopper New Time or SCU New Time 	
	 fields as required.

3.	 In the Service Tool application, click the File Menu and select Reset Key. The Generate Reset Key 	
	 Dialog dialog appears.

4.	 Copy the ECU Serial Number, Chopper New Time, SCU New Time, and Reset ID fields from the 	
	 Android Tablet to the Generate Reset Key dialog.

5.	 Click Generate.

6.	 Type the generated Reset Key into the provided field in the Android Tablet.

7.	 Tap Initialize on the Android Tablet.

Note

The values entered for Chopper New Time and SCU New Time are minutes. To calculate the correct value, 
the hours must be multiplied by 60 and added to the minutes. For example, for 43 hours and 12 minutes, 
the calculation would be (43 * 60) + 12 = 2592.

Warning

The values entered into the Generate Reset Key dialog must agree precisely with the values on the 
Factory Initialization screen on the Android Tablet. A single incorrect digit will result in the incorrect key 
being generated.
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3   User Interface 

	 •	 Main Window
	
	 •	 Menus

	 •	 Options

	 •	 Programming Commands

	 •	 Edit Dialog

	 •	 Generate Reset Key Dialog

	 •	 Empty Serial Number Dialog

	 •	 ECU Feature Codes dialog

	 •	 Android Tablet Packages Dialog



18

3.1   Main Window
 

The main Service Tool window contains the following sections, from top to bottom:

	 •	 Menus - See Menus.
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	 •	 Serial Port - The Serial Port section contains the Port dropdown menu and the Connect 	
		  button which are used to connect to the ECU.

	 •	 ECU - The ECU section displays information about the currently connected ECU, such as 	
		  the ECU Version, Serial Number, and currently installed Firmware Version.

	 •	 Target Firmware - This section contains the list of included firmware available to install and 	
		  verify on the ECU. The version selected here will be installed when the Write or Bulk 		
		  commands are used, and will be verified if the Verify command is used.
		  The latest firmware version is selected by default.
	
	 •	 Custom File - This section shows the selected custom firmware file if selected. A custom 	
		  firmware file may need to be installed if instructed by Redekop technical support. Selecting a 	
		  custom firmware file will override the Target Firmware selection. Likewise, selecting 		
		  a Target Firmware will override the custom file selection. Edit and Reset commands are not 	
		  available when using custom firmware files.

	 •	 Options - The options in this section allow the user to specify how the ECU is configured 	
		  after updating the firmware using the Write or Verify commands. See Options.

	 •	 Actions - The Actions section contains the Write, Verify, and Bulk command buttons. 		
		  There is also a progress display and Cancel button to cancel the current operation. See 		
		  Programming Commands.

	 •	 Log - The Log displays a trace of operations executed by the Service Tool along with a time 	
		  stamp. Use the Verbose check box to see additional details in the log.
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3.2   Menus
3.2.1   File Menu

Command		  Icon		  Hotkey	 Description

Open File	  			   Ctrl+O		 Selects a custom firmware file.

Reset Key	  			   Ctrl+R		  Opens the Generate Reset Key dialog.

Feature Codes	  		  Ctrl+F		  Opens the ECU Feature Codes dialog.

Tablet Packages			   Ctrl+T		  Opens the Android Tablet Packages dialog.

Quit	  				    Ctrl+Q		 Quits the application.

3.2.2   Edit Menu

Command		  Icon		  Hotkey	 Description

Edit Configuration	  	 	 Ctrl+C		  Reads the installed features, settings, and 			 
							       calibrations from the currently connected ECU and 		
							       allows for editing and saving the configuration.

Edit Hours	  			   Ctrl+H		  Reads the Chopper and SCU hour meters from the 		
							       currently connected ECU and allows for editing and 	
							       saving the values.

3.2.3   Reset Menu

Command		  Icon		  Hotkey	 Description

Reset Configuration	 	 	 Ctrl+Shift+C	 Clears the installed features, settings, and calibrations 	
							       and resets the configuration to factory default values.

Reset Hours	  			   Ctrl+Shift+H	 Resets the Chopper and SCU hour meters to zero, and 	
							       resets any applicable service intervals on the currently 	
							       connected ECU.

Clear Alarms	  			   Ctrl+Shift+A	 Clears the alarm history from the currently connected 	
							       ECU.

Factory Reset	  		  Ctrl+Shift+F	 Completely resets the currently connected ECU to 		
							       factory default values, including installed features, 		
							       settings, calibrations, hour meters, service intervals, 	
							       and alarm history.
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3.2.4   Advanced Menu

Command		  Icon		  Hotkey	 Description

Bootloader Version	  	  			   Selects the bootloader version to be installed with the 	
							       Write Bootloader command.

Write Bootloader	  		  Ctrl+B		  Installs the currently selected bootloader.

							       Note: For use only when instructed by Redekop 		
							       technical support.

Check Memory	  	  			   Validates the saved ECU configuration, hour meters, 	
							       and alarm history memory.

Memory Addresses	  	  			   Directly edit raw memory.

							       WARNING! For use only when instructed by 		
							       Redekop technical support. 
							       Editing memory could result in lost data.
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4   Options

Option			  Description									         Default

Upgrade 		  If checked, the bootloader is automatically updated when required.		 Yes
Bootloader		
			   If unchecked, the user will be prompted to update the bootloader 
			   and allowed to cancel the operation.
				  
			   It is recommended to always update the bootloader to avoid 		
			   memory errors when updating firmware.	

Verify After 		  If checked, the Service Tool will perform a Verify command 			  No
Write			   immediately after completing a Write command. This option 
			   applies to Bulk mode as well.

			   If unchecked, verification will be skipped.

			   Most of the time, verification isn’t required unless instructed by 
			   Redekop technical support.	

Reset 			  If checked, the Service Tool will reset installed features,			   No
Configuration	 settings, and calibrations to default values after updating
			   firmware. This can be used when upgrading new ECUs prior to 
			   installation, or if the default values are desired when upgrading 
			   firmware.

			   If unchecked, the Service Tool will attempt to keep installed 
			   features, settings, and calibrations if possible.

Reset Hour		  If checked, the Service Tool will reset the Chopper and SCU hour		  No
Meters			  meters to zero after updating firmware. It will also reset any 
			   applicable Service Intervals. This can be used when upgrading 
			   ECUs prior to installation, or if transferring ECU to a different 
			   machine, etc. 

			   If unchecked, the current hour meter values and Service Interval 				  
			   values will be kept if possible.

Clear Alarm 		  If checked, the Alarm History will be cleared after updating the 		  No
History	 	 firmware.

			   If unchecked, the Alarm History will be kept if possible.	
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5   Programming Commands

Command	 Icon		  Description

Write	  			   The Write command erases the ECU program memory, writes the 	selected
				    firmware, optionally verifies the newly installed firmware, and updates the 
				    configuration memory according to the selected Options.

Verify			    	 The Verify command reads the ECU program memory and compares it to the
				    selected firmware. This command is normally only used when instructed by
				    Redekop technical support.

Bulk	  			   The Bulk command performs the Write command on multiple ECUs in a 		
				    loop. After a Write command finishes, a new ECU can be connected and the
				    process automatically resumes, continuing until the user cancels the
				    command, ideally after programming the final ECU.
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6   Edit Dialog

Use the Edit dialog box to alter ECU configuration as desired.
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The Edit dialog box can be accessed by using the Edit Configuration or Edit Hours commands. 
See Edit Commands.

After the current configuration is read from the ECU, the Edit dialog is displayed. The fields available on 
the Edit dialog depend on the currently installed firmware on the ECU. Only features and settings that are 
supported by the currently installed firmware version are shown.

Click the Save button to save the configuration back to the ECU. Click the Cancel button to undo all 
changes and leave the configuration as-is.

Warning

In the case of an error reading the ECU configuration, the Edit dialog box will be populated with the default 
values for each field. Clicking Cancel will not save these default values and leave the ECU configuration 
as-is.
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7   Generate Reset Key Dialog 

Use the Generate Reset Key dialog box to generate a key when performing a Factory Initialization with an 
Android Tablet.

The Generate Reset Key dialog box is accessed by clicking the File Menu and clicking Reset Key. 
The fields in the dialog box must match the Android Tablet precisely to generate the correct reset key. 
See Factory Initializing Android Tablet.

7.1   Fields
	 •	 ECU Serial Number - The serial number of the ECU as shown on the Android Tablet.

	 •	 Chopper Time - The number of minutes that the Chopper hour meter will be set to. Hours 	
		  must be converted to minutes by multiplying by 60.

	 •	 SCU Time - The number of minutes that the SCU hour meter will be set to. Hours must be 	
		  converted to minutes by multiplying by 60.

	 •	 Reset ID - A unique ID that is generated each time the Factory Initialization page is opened 	
		  on the Android Tablet. This must be entered at the time of initialization to ensure that it is 	
		  correct. 

Click the Generate button to generate the key based on the entered fields.
	
	 •	 Reset Key - The unique key that is generated to authorize the initialization and set the hour 	
		  meters. After generation, it must be entered into the Android Tablet to complete initialization.
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8   Empty Serial Number Dialog 

Use the Empty Serial Number dialog box to program the serial number into a new ECU.

The Empty Serial Number dialog box is accessed by connecting a blank ECU and clicking Connect. 
The user will be prompted to enter the serial number of the currently connected ECU.

Click OK to save the entered serial number to the ECU. Click Cancel to leave the serial number blank (not 
recommended).
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9   ECU Feature Codes dialog 

The ECU Feature Codes dialog lists all the available feature codes for the Redekop ECU.
 

The feature codes are listed beginning with the minimum required firmware version, feature code value, 
and feature description. For example:

(v01) 53235: Seed Control Unit
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10   Android Tablet Packages Dialog

Use the Android Tablet Packages dialog to manage installation packages on an Android Tablet.

The Android Tablet Packages dialog box is accessed by clicking the File Menu and clicking Tablet 
Packages. See Updating Android Tablet App.

	 • Target - Used to choose the connected device being managed. Use the Rescan button to update 	
	 the list of available devices in the drop-down menu.

	 • Device - Shows information about the selected device, including Model, Serial Number, Battery 	
	 Power Level, and Used Storage Space.

	 • Upload Install Package - Choose the desired Android Tablet app version from the drop-down
	 menu.The required ECU firmware version is shown along with the Tablet app version. Use the 		
	 Upload button to upload the installation package to the device selected in the Target box.

	 Uploading the package does not install the update. The installation must be completed on the 		
	 Tablet. See Updating Android Tablet App.

	 Note: The ECU firmware version must be matched to the installed Android Tablet app version for 	
	 the system to function. Ensure ECU is updated to the required firmware version.

	 • Packages Already on Device - Shows the detected installation packages that are already on the 	
	 Tablet. Use the Delete button to remove the selected package from the Tablet.

	 Deleting installation packages does not remove the currently installed version of the app from the 	
	 Tablet.
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